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1. Getting Started

Thank you for  choosing to  purchase "The Earth Centered Universe",  ECU for  short.   ECU is  a  Sky
Visualization Program capable of simulating many of the phenomenon of the Earth centered sky.  This includes, but
is not limited to, the stars, planets, Sun, and Moon, comets, asteroids, and "deep sky" objects.  

ECU also  provides  a  comprehensive  interface  to  today's  computerized  telescopes,  including  Meade's
LX200/LXD series, the Jim's Mobile, Inc. SGT-MAX and NGC-MAX series, and others.

ECU is designed as an observing tool for the observing amateur astronomer, but is equally useful to the
"armchair" astronomer or other person interested in learning about astronomy.

Many of the concepts and terms used in this manual are common in amateur astronomy, but may not be
familiar to all users.  The author recommends the purchase of a good beginner book in astronomy as a guide to the
understanding of the concepts provided by this program.  An excellent beginner's book is:  NIGHTWATCH: An
Equinox Guide to Viewing the Universe by Terence Dickinson, which is available in most well stocked bookstores
or libraries.

ECU is designed to operate on a PC from within the Microsoft Windows 3.0 or 3.1 environment.  This
environment provides all of the "tools" necessary to support a highly graphical program like  ECU.  This manual
assumes that the user is familiar with the operation of typical Windows 3 programs.

ECU was written,  because of the obvious lack of good, reasonably priced astronomy programs.  Most
"commercial" software products (and the author has purchased many of the high profile programs) suffer from very
awkward user interfaces and slow operation (especially without a math processor).  ECU, therefore, attempts to fill
an obvious need at the reasonable price. 

A large amount of effort in software development has gone into "The Earth Centered Universe".   It  is
currently comprised of about 425 pages of program listing.  This release, V1.5, includes a many enhancements over
previous versions (ECU was first released as V1.1 in March of 1992).  

If you have purchased this copy of ECU from a retailer, be sure to send in the accompanying registration
form, so you can be informed by mail when upgrades to ECU are available.

The author would be most pleased in hearing your comments and suggestions for improvements to ECU or
this manual.  I would also like to hear about any "bugs" which you detect so they can be fixed in a future release.
The author can be reached at any of the addresses (post office and e-mail) listed on the cover page of this manual.

1.1 System Requirements

As stated in section 1., ECU operates within the Microsoft Windows 3.x environment.  It will not run under
DOS alone.  However, it has been tested for operation under IBM OS/2 2.x.  The minimum system requirements are
listed below:

Hardware: 386SX/386DX/486  100%  PC  Compatible  Computer  (386DX  or  higher
recommended)

Math Co-processor: 80x87 supported and recommended, but not required (highly recommended when used
with a 386SX)

Software: DOS 3.x or higher
Microsoft Windows 3.0 or 3.1
(standard or enhanced mode)



Memory: Minimum 700K bytes free from within Windows
Minimum 1M bytes free with enhanced stellar database
(some  program  features,  especially  if  you  have  a  high  resolution

display, may require more memory)
Disk Capacity: REGISTERED VERSION - 2.3M bytes

WITH ENHANCED 
STELLAR DATABASE - 5.5M bytes

Graphics Card: An EGA or better graphics card 
(VGA or Super VGA recommended)

Monitor: Colour monitor recommended
Mouse: Windows compatible
Printer (optional): Windows compatible printer or plotter

The use of a math co-processor is supported and recommended, but not required.  With most programs, this
statement means that it works, but is intolerably slow!  ECU's sky drawing routines are written almost entirely
written in integer math, thus operate quickly with or without the math processor.  

The  math  processor,  however,  does  dramatically  speed  up  local  horizon,  planet,  Sun,  Moon,  and
comet/asteroid orbit calculations.   The high accuracy solar system calculations are very CPU intensive, and thus a
math co-processor is recommended when used on 286 and 386SX computers.

1.2 Installation Instructions

ECU is  distributed  as  one  file  (ECUREG.EXE)  in  self  uncompressing  format.   The  compressed  file
contains the files listed below.  If you ordered the optional ENHANCED STELLAR DATABASE, you will have
received two additional disks (labeled SAO 1 and SAO 2).

MAIN PROGRAM DISK

ECU.EXE - the main executable program file
ECU.CFG - the default configuration file
BOUNDS.ECU - constellation boundaries data file
YBSC1.ECU - the main Yale Bright Star file
YBSC2.ECU - the secondary Yale Bright Star file
SAC1.ECU - the main "deep sky" object file
SAC2.ECU - the secondary "deep sky" object file
CONS.ECU - the constellation data file
LABELS.ECU - the text labels data file
LOCATION.ECU - the geographic location data file
PTERMS.ECU - the orbital terms used for high accuracy calculations
PINDEX.ECU - the index file for PTERMS.ECU

ENHANCED STELLAR DATABASE VERSION

SAO1.ECU - the primary Smithsonian Astrophysical Observatory star file
SAO2.ECU - the secondary Smithsonian Astrophysical Observatory star file

Installation of ECU is straight forward.  The example below assumes that your hard disk is drive 'C', and
your floppy disk is drive 'A'.  Substitute drive letters, as required.  You can install ECU from DOS or from a "DOS
Shell" within Windows 3.

TYPE



1. Log to your hard disk: C:
2. Make a directory to store ECU: MD\ECU
3. Change to the ECU directory: CD\ECU
4. Install the ECU "Main Program Disk" in drive 'A'
5. Extract the files from ECUREG.EXE:

A:\ECUREG
6. If you don't have the enhanced stellar database disks,

go to step 11.
7. Install the ECU "SAO1 Disk" in drive 'A'
8. Extract the files from SAO1.EXE A:\SAO1
9. Install the ECU "SAO2 Disk" in drive 'A'
10. Extract the files from SAO2.EXE A:\SAO2
11. Start or Exit Windows: WIN or EXIT
12. Start the "File Manager" (using the mouse)
13. Open the ECU directory such that the ECU.EXE file is visible.
14. Arrange the screen so that ECU.EXE and a suitable program group in the "Program Manager" are both

visible.
15. Drag ECU.EXE from the "File Manager" to the "Program Manager".  A colourful Icon should appear.
16. Proceed to section 1.3: Starting ECU.

If your hard disk space is limited, the space used by ECU can be reduced by deleting several files.  If you
are not interested in the spectral type or SAO designation of stars in the ENHANCED STELLAR DATABASE, you
can delete the file "SAO2.ECU".  This will reduce  ECU's hard disk space requirement by slightly less than two
megabytes.  The file "YBSC2.ECU" can be deleted if the extended information in the Yale Bright Star catalogue is
not desired.  This will save an additional 500 kilo-bytes.  ECU will automatically detect the absence of these files
and adjust its operation accordingly.

1.3 Starting ECU

ECU is started by double-clicking the ECU Icon.  Loading ECU typically takes a few seconds.  

Before the "main window" appears, several data files, plus the configuration file are loaded into memory.
If any problem is encountered while loading ECU (due to bad or missing files, not enough memory, etc.), a small
dialog  box displaying  a  descriptive  message  is  displayed  on  the  screen.   Pressing  'OK'  will  return  control  to
Windows 3. 

If  all  is  successful,  the  opening  screen  will  appear  greeting  the  user  with  a  colourful  display  of  the
constellation of ORION similar to that shown on the cover of this manual.

At this time, only one copy of ECU can be running at any one time.  If the user attempts to run a second
copy of ECU, a small dialog box will appear describing the problem.

By default, ECU always uses the configuration file "ECU.CFG" located in the current directory.  If a file
name is specified on the command line,  ECU uses the specified file.  This is useful for setting up ECU 'icons' to
quickly bring up saved astronomical events.

I suggest you read sections 2. and 3. next, which introduce the operation of the program, and address all of
the menu selections.  If you just want to explore, that's fine, too.  I think you will find ECU quite intuitive.  Section
4. then describes the built-in databases.



2. Introduction

This section assumes that ECU is installed and is running.  Mouse operations are integral to the operation
of ECU, and will be described in Section 2.3.  The on-screen controls, such as the check boxes and scroll bars will
be described in  Section 2.4,  the keyboard quick-keys are described in  Section 2.5,  and the menu selections in
Section 3.  But first, the on-screen status displays and sky display area will be described.

2.1 The Status Display

The left portion of the ECU window comprises the status display area.  This area contains the following
items:

a) Geographic Location - the top line shows the city where the observer is located.  If a city was not selected
(but  rather  a  specific  latitude/longitude  was  entered),  the  message  "By  Lat/Long"  will  be  displayed.
Immediately below, the latitude (Lat) and longitude (Long) of the observer is displayed as degrees and
minutes.  Positive latitudes are North of the equator and positive longitudes are West of the Greenwich
meridian.  To set  your geographic location, see section 3.3.2,  which describes the "Set -> Geographic
Location" menu selections.

b) Local Mean Time (LMT) - contains the date and time of the local civil time.  The date is always in the
format year/month/date.  The time is either displayed as hh:mm in 24 hour time or hh:mmpm in am/pm
format.  See section 3.3.1.4.

c) Universal Time (UTC) - contains the universal date and time (that of the Greenwich meridian).  The date
is always in the format year/month/date.  The time is always displayed as hh:mm in 24 hour time format. 

d) Right Ascension (RA) - contains the right ascension of the center of the sky display.  It is formatted in
hours and minutes as hh:mm.m.

e) Declination (Dec) - contains the declination of the center of the sky display.  It is formatted in degrees and
minutes as +dd mm'.

f) Azimuth (Azim) - contains the azimuth of the center of the sky display.  The azimuth is the angle, in
degrees  and  minutes,  from the  Northern  horizon  towards  the  East  at  the  current  Date  and  Time  and
Geographic Location.

g) Altitude (Alt) - contains the altitude of the center of the sky display.  The altitude is the angle, in degrees
and minutes, measured vertically from the horizon at the current Date and Time and Geographic Location.

h) Field Size (Field) -  contains the number of vertical  degrees currently shown in the sky display.  The
minimum field size is 2 degrees and the maximum is 180 degrees.

i) Magnitude (Mag) - contains the minimum magnitude for which stars are displayed in the sky display.
This number is usually the same as that set in the "Set -> Magnitude Limits..." menu selection, however to
keep the sky drawing speed fast, the maximum magnitude of stars displayed changes with the field size.
This ranges from magnitude 4.0 for fields larger than 120 degrees to magnitude 8.5 for field sizes from 10
to 15 degrees.  See section 3.4.2, which describes the "Set -> Magnitude Limits..." menu selection. 

j) Animation Time Step - contains the size of the time step used by the animation mode in minutes, hours,
days, months, or years.  If an arbitrary time step has been entered, the word "Manual" will be shown.



2.2 The Sky Display

The right portion of the  ECU window is the sky display area.  The sky display area displays celestial
objects using one of three "projections".  These three projections were selected for the speed of their calculation,
however there is some distortion at the limits of their usefulness.

When displaying the sky from -45 to +45 degrees Declination and a field size of 60 degrees or less, a
simple  modified-Mercator projection  is  used.   This  projection  causes  the  objects  at  high  Declinations  to  be
distorted (spread-out), most noticeable in constellations like Ursa Major (the big dipper).  This is the same distortion
that makes Canada appear much larger than the United States on world maps with similar projections (Canada is
only about 10% larger).

When displaying the sky either North of +45 or South of -45 degrees in Declination and a field size of 60
degrees or less, the  Zenithal Equidistant Projection is used.  This projection is quite good, but does spread out
objects a bit at low Declinations.

When displaying the sky with field sizes larger than 60 degrees, an Orthogonal Projection is used.  This
projection is essentially a sphere (like the Earth) viewed from infinity.  It can show an entire hemisphere of the sky
at once, but suffers from distortion at the edges of the field.

With all
three projections, the North Celestial Pole is always up (South is down) and East is to the right (West is to the left).
The local horizon is not parallel to the bottom of the screen, but rather is tilted a varying amount dependent on the
latitude entered.  A future version of ECU will support a "Local Horizon" display mode.

The objects and items displayed in the sky display area are listed below.  Each will be discussed in detail in
sections 3. and 2.4 by the specific menu selection or screen resource which controls their operation. 

a) Grid - the coordinate grid helps illustrate the sky projections just described.  Lines of Right Ascension are
drawn every hour (coarse grid) or every 20 minutes (fine grid).  Lines of Declination are drawn every 10
degrees (coarse grid) or every 5 degrees (fine grid).

b) Stars - stars are displayed as varying sized dots according to the star's brightness.  The larger the dot, the
brighter the star.

c) Lines -  there  are  many lines  displayed  by  ECU.   These  include  the  constellation  lines,  constellation
boundary lines, horizon line, ecliptic line, and telescope field of view lines.  Markers are also displayed at
the Zenith (the overhead point) and the North and South poles.

d) Labels -  there  are  text  labels  displayed  for  solar  system objects,  bright  stars  names,  Messier  objects,
constellation names, and labels for the coordinate grid, ecliptic and horizon lines, and markers.

e) Solar System objects - the planets, sun, moon, comets and asteroids are displayed.  The sun and moon are
displayed to their correct size and the phase of the moon is shown.  Planets are displayed as either a point
or by their standard symbol.  Comets are displayed as points.  

f) Deep sky objects - deep sky objects are displayed in six different categories.  These are Galaxies, Open
Clusters, Globular Clusters, Bright Nebulae, Planetary Nebulae, and Other; each displayed using a different
symbol.

2.3 Mouse Operations

The mouse forms a vital part of the ECU user interface and has many uses from within ECU.  The cursor



(the shape of the mouse pointer) is used to inform the user of how the mouse is currently being used.  If it is a cross-
hair, it is used for selecting a window, identifying an object, centering, or measuring an angle.  The cursor is always
a cross-hair while in the sky display area.  If it is an arrow, it is used for operating the scroll bars or buttons.  

If it is the planet Saturn, ECU is busy computing solar system positions.  If it is an hour-glass, ECU is busy
performing some other task; usually drawing the sky display.

Each mouse button will be described separately in the next two sections.

2.3.1 Left Mouse Button

The left mouse button, while the cursor is in the sky display area, is used for the following functions.

a) Select an object - if the left mouse button is pressed (and released) within a few pixels of the center of an
object, a dialog box, called the "Identify Object" dialog box, will appear identifying and describing the
object.  Section 5. details the contents of the "Identify Object" dialog box.  A cross-hair will appear on the
screen identifying the object currently selected.  The dialog box is always placed in the diagonally opposite
corner from the object selected, so that it doesn't cover the object selected.  The dialog box can, of course,
be moved about the screen as the user wishes.

If more than one object is in the vicinity, the "Next" button can be pressed to update the dialog box
with new information for the next object.  The "Precess" button precesses the objects coordinates to the
epoch of the current date.  The "Show" button will show a picture of the object (if one exists) on the screen.

The dialog box can be terminated in four ways.  If the "Quit" button is pressed, the dialog box will
terminate immediately.  If another object is selected, the current dialog box will be replaced with a new
one.  If the left mouse button is pressed while the cursor is not near an object, the dialog box will terminate.
Finally, the <ESC> key can be pressed.

For more information about the "Identify Object" dialog box, see Section 5.

b) Zoom a window - the second function performed by the left mouse button is its ability to draw a rectangle
on the  screen  which  is  used  to  re-position  and  re-scale  the  sky  display.   The  rectangle  is  drawn  by
positioning the mouse at one corner, dragging the mouse (with the left mouse button pressed) to another
corner, and then releasing the button.  The center of the rectangle defines the new display center and the
vertical height is used to scale the display.

2.3.1 Right Mouse Button

The right mouse button, while the cursor is in the sky display area, is used for the following functions.

a) Center the mouse position - if the right mouse button is pressed (and released), the current mouse position
will become the center of the sky display at the current scale.  This feature is very useful for quickly
"panning" about the sky.

b) Measure an angle - the second function performed by the right mouse button is its ability to measure
angles on the sky.  Angles are measured by positioning the mouse at one location, dragging the mouse (with
the right mouse button pressed) to another location, and then releasing the button.  A dialog box will appear
which displays the angular measure between the two points in both degrees & minutes and in decimal
degrees.  It also provides the differences in Right Ascension and Declination between the two points.  This
feature is useful for those who find objects with their telescope by offsetting angular distances in each axis
from a bright star.



2.4 On-Screen Controls

The on-screen  controls  include  the  scroll  bars,  zoom buttons,  check  boxes,  and  time step arrows  and
buttons.  Each is described below:

a) Scroll Bars - Two scroll bars are used to rapidly move the center of the sky display about the celestial
sphere.  The scroll bars are used in two modes as controlled by the menu selection described in section
3.4.10.

1) The vertical bar is used to change the Declination.  +90 degrees is at the top; -90 degrees is at the
bottom.  Pressing the end arrows will move the pointer (and the sky display) by one degree and pressing
along the  bar  will  move the  pointer  by  10 degrees.   The  horizontal  bar  is  used  to  change the  Right
Ascension.  23 hours 59 minutes is at the left; 0 hours is at the right.  Pressing the end arrows will move the
pointer by 4 minutes and pressing along the bar will move the pointer by one hour.  When sliding the scroll
bars by dragging the pointer, observe at the Right Ascension and Declination displays to know when to
stop.

2) The vertical bar is used to change the Altitude with reference to the local horizon.  +90 degrees is
at the top (the Zenith); -90 degrees is at the bottom (the Nadir).  Pressing the end arrows will move the
pointer (and the sky display) by one degree and pressing along the bar will move the pointer by 10 degrees.
The horizontal bar is used to change the Azimuth with reference to the local horizon.  0 degrees (North) is
at the left; 358.5 degrees is at the right.  Pressing the end arrows will move the pointer by 1.5 degrees and
pressing along the bar will move the pointer by 15 degrees.  When sliding the scroll bars by dragging the
pointer, observe at the Azimuth and Altitude displays to know when to stop.

b) Zoom buttons - the zoom buttons, identified as "Z-IN" and "Z-OUT", are used to change the scale of the
sky display.  Each press of the respective button changes the scale by a factor of two.

c) Check boxes - the six check boxes: Stars, Deep Sky, Solar System, Grid, Lines, and Labels are used to
toggle whether the respective item is displayed in the sky display.  Note that when operating with graphics
boards providing less than 350 pixels in vertical resolution, only the Stars and Deep Sky check boxes are
available.

d) Time step arrows and buttons - the time buttons "+" and "-" are used to change the current time by the
amount shown at the immediate left.  Pressing the black arrows causes the amount at w
hich the time changes to be altered in steps from a minimum of 1 minute to a maximum of 4 years. 

e) Speed buttons - the boxes in the status area, which are used to display the current settings of parameters
ranging from the Geographic Location to the Animation Time Step (see section 2.1),  are also used to
provide quick access to the menu items which control the respective parameter.   When the left mouse
button is pressed while the mouse is within one in the boxes cause the appropriate dialog box to "pop-up".
For example, the left mouse button is pressed within the "Mag" box, the "Magnitude Limits..." dialog box
will pop-up.

2.5 Keyboard Quick Keys

Most of the functions of ECU can be operated from the keyboard, however the mouse interface is much
more efficient.  There are many key combinations that speed up access to common functions.  These are listed
below:

a) Alt-S equivalent to: File -> Save



b) Alt-A equivalent to: File -> Save As...
c) Alt-E equivalent to: File -> Exit
d) Alt-F4 equivalent to: File -> Exit
e) Alt-Backspace equivalent to: Edit -> Undo
f) Alt-T equivalent to: Set -> Time -> Set Local Time...
g) Alt-N equivalent to: Set -> Time -> Set Time to System Time (the 'N' stands for 

Now)
h) Alt-U equivalent to: Set -> Time -> Use System Time
i) Alt-L equivalent to: Set -> Geographic Location -> By Latitude/Longitude...
j) Alt-C equivalent to: Set -> Geographic Location -> By City/Town...
k) Alt-M equivalent to: Field -> Magnitude Limits...
l) Alt-O equivalent to: Field -> Object Selection...
m) Alt-P equivalent to: Field -> Planets...
n) Escape stops the execution of animation mode
o) Alt-Z zooms the sky display to full zoom out (180 degrees)
p) Shift-Z zooms the sky display to full zoom in (2 degrees) 
q) Shift-M centers the sky display on the Moon
r) Shift-S centers the sky display on the Sun
s) N centers the sky display on the local northern horizon
t) S centers the sky display on the local southern horizon
u) E centers the sky display on the local eastern horizon
v) W centers the sky display on the local western horizon
w) Z centers the sky display on the local zenith (the overhead point)
x) B silences the system beeper if it is "beeping" while searching for an object with

the telescope encoder interface
y) + equivalent to: Animation -> Forward One Step
z) - equivalent to: Animation -> Reverse One Step
aa) Insert equivalent to: Animation -> Time Step -> Increase 
ab) Delete equivalent to: Animation -> Time Step -> Decrease

3. Menu Selections

The menu selections control most of the features of  ECU and are divided into eight categories as listed
below.  Each is described in detail in the identified sections:

a) File - the file menu handles the loading and saving of the configuration settings of ECU including comet
and asteroid orbits, and the printing of star charts. (see section 3.1).

b) Edit - edit allows the last operation to be nullified (see section 3.2).
c) Set - the set menu allows the time, geographic location,  solar system calculation settings, atmospheric

refraction flag, comet and asteroid orbits, sky display colours, and sky drawing mode to be adjusted (see
section 3.3).

d) Field - the field menu controls if and how the stars, deep sky objects, planets, sun/moon, grid, lines, and
labels are displayed.  It also allows for various zoom settings (see section 3.4).

e) Center - the center menu allows many ways to set the center of the sky display.  These ways include
centering  on  a  specified  Right  Ascension/Declination,  a  specified  Azimuth/Altitude,  a  constellation,  a
bright star, a Messier object, a Solar System object, a point on the local horizon, or by a text search of the
databases (see section 3.5).

f) Animation - the animation menu controls the various features of the animation mode (see section 3.6).
g) Miscellaneous - the miscellaneous menu provides access to various functions which didn't seem to fit well

anywhere else.  These include the display of Sun/Moon data and sidereal time and Julian date, the settings
for displaying images from within ECU, and the telescope control functions (see section 3.7).

h) Help - the help menu lists the program credits, the version number, etc. (see section 3.7).



Many of the common menu items have "short cut" keyboard keys to allow quick access to their features.
The keys used are identified by an underline under the key used.  The Alt key is to be pressed in conjunction with
the identified key.  Also, some menu items identify their keyboard equivalent to the right in their menu item.  For
others, see section 2.5.

3.1 File Menu

The File menu allows the configuration settings of ECU to be loaded (opened) and saved.  Virtually every
setting in ECU is stored in the configuration file.  This allows ECU to be "set up" for a particular astronomical event
and this event saved to a unique configuration file for later quick retrieval.

The file menu also provides access to setup printers and to print high-quality star charts of the current sky
display.

3.1.1 Open

The  Open... menu  selection  presents  a  dialog  box  allowing  a  new  configuration  file  selected,  then
subsequently loaded.  It defaults to file names with the extension ".cfg".  

I will not detail the operation of this dialog box, since it is identical to every other MS-Windows application
that has an Open... function.  Please note that you cannot open configuration files created with previous versions of
ECU.

3.1.2 Save

The  Save menu selection saves the current configuration settings to the current configuration file name.
The current  file  name is  always displayed on the  ECU Window title.   The keyboard equivalent  to  this  menu
selection is Alt-S.

3.1.3 Save As

The Save As... menu selection saves the current configuration settings to the file specified by the file name
selected in the dialog box presented.  I will not detail the operation of this dialog box, since it is identical to every
other MS-Windows application that has a Save As... function.   The keyboard equivalent to this menu selection is
Alt-A.

3.1.4 Revert

The  Revert menu selection re-loads the configuration settings from the current configuration file name.
The  current  file  name  is  always  displayed  on  the  ECU Window title.   This  function  is  commonly  found  in
Macintosh programs, and is useful, for example, if you have loaded a configuration file (or started ECU), made
some changes to these configurations, then subsequently changed your mind and want to start over. 

3.1.5 Set Defaults



The  Set Defaults menu selection sets all  configuration settings to the system defaults.   This selection
should be used carefully, since it changes all of the configuration settings, including removing all the comets and
asteroids which you may have entered.

3.1.6 Print Chart

The Print Chart menu selection prints a high-quality chart of the sky display on the printer selected and
setup in Printer Setup....   The chart is printed with the same settings used to draw the sky display.  The chart is
printed in two formats.  In either format, a title box can be printed at the bottom of the page containing the chart
title, geographic location, the universal and local date and time, the center of the chart as the right ascension and
declination, the center of the chart as the azimuth and altitude, and the height of the field.

If the printer is set in portrait mode (or, if the height of the paper is larger than its width), a legend box can
be drawn above the title box.  If the printer is set in landscape mode (or, if the width of the paper is larger than its
height), a legend box can be drawn on the right side of the page.  This legend box shows the stellar magnitude limit
and the star symbols used, the deep sky magnitude limit and the deep sky symbols used, and an area for your notes.  

A sample chart printed in Landscape mode (with both the title and legend boxes enabled) on an Okidata
OL400 300 dot/inch laser printer (suitably sized to fit in this manual) is shown on the next page. 

If you have any difficulties printing charts, 
the author would like to hear from you.  Although ECU has been tested with many printers, there are bound to be a
few printers that may cause problems.  Please send the symptoms, a sample chart, your ECU.CFG file, and the type
of printer and Windows driver (and version) that was used.  

3.1.7 Printer Setup

The Printer Setup... menu selection presents a dialog box allowing the user to select and setup a printer to
be used by ECU.  The dialog box contains a drop down pick list and three buttons.  The printer to be used is selected
from the pick list.  To change the default settings for the selected printer, press the "Setup..." button.  This will
activate the printer's setup dialog box where such items as the printer's resolution and the page size and orientation
(portrait or landscape) can be set.  All changes to the printer's settings remain in effect until ECU is terminated.

Ending the  dialog box is  accomplished  by  pressing  the  'OK'  button.   Aborting,  without  changing  the
printer's settings, is accomplished by pressing 'Cancel'.  

3.1.8 Chart Setup

The Chart Setup... menu selection presents a dialog box allowing the user to customize the appearance of
the printed star charts.  The title line of the chart can be customized by selecting the "custom title" radio button and
entering new title text to its right.  The standard title is: "The Earth Centered Universe from.... "

The legend box, which shows the symbols used for stars of different brightness and deep sky objects of
different types, can be enabled or disabled by using the "legend box" check box.

The title box, which shows the chart title,  time, geographic location and other data, can be enabled or
disabled by using the "title box" check box.

The four border distances in inches can be individually set.  This, in effect, allows the chart size to be
controlled.  This feature is very useful for making charts that can be "pasted" into other documents, such as an



astronomy club newsletter.  Another project could be to make up a set of small-sized charts of the Messier objects; a
project the author plans to undertake.

The "symbol scale factor" setting allows the user to increase or decrease the size of the star, deep sky, and
other symbols drawn on the chart.  Printers of varying resolutions (pixels per inch) may produce higher quality
output at values other than the standard setting of one.  Experiment with this setting to determine the best setting for
your printer.

If the user enters values smaller than one, the symbols will be drawn proportionately smaller.  Likewise, if
the user enters values larger than one, the symbols will be drawn proportionately larger.

Ending the dialog box is accomplished by pressing the 'OK' button.  Aborting, without changing the chart
settings, is accomplished by pressing 'Cancel'.  

3.1.9 Load Orbits

The  Load Orbits... menu selection is used to load the orbital information for comets and asteroids.  It
presents a dialog box allowing an orbital data file to be selected, then subsequently loaded.  It defaults to file names
with the extension ".orb".  

The format of the file loaded is specific to ECU, but is in ASCII format, thus can be altered by any text
editor, such as the Windows Notepad.  ECU supports up to 50 comets and asteroids active at any one time; referred
to as "Comet/Asteroid 1" to "Comet/Asteroid 50".  When the file is loaded, the first entry in the file will replace
"Comet/Asteroid 1" and continue until the end of the file.  No more than 50 entries will be loaded.

A sample comet entry follows:

Comet Lane 1994J
E  C  2000  1994  12  5.445  0.852  0.9565  45.566  180.765  -34.321 4.0  10.0   

Each entry contains two lines.  The first line contains the name of the comet (up to 25 characters).  The
second line contains 13 entries of orbital data separated by a space in the following order: Enable (an 'E' if the comet
is enabled, a 'D' if it  is disabled),  Orbit type (always a 'C' for a comet), Epoch, Year, Month, Date,  Perihelion,
Eccentricity,  Argument of Perihelion, Longitude of Ascending Node,  Inclination, Magnitude Parameter 'H', and
Magnitude Parameter 'G'.  For a description of each entry, see section 3.3.5.

A sample asteroid entry follows:

Asteroid Lane 4563
E  A  2000  1994  1  3.2  0.4544  4.54  0.045  6.4343  54.3232  5.5845  4.0  5.0

Each entry contains two lines.  The first line contains the name of the asteroid (up to 25 characters).  The
second line contains 14 entries of orbital data separated by a space in the following order: Enable (an 'E' if the
asteroid is enabled, a 'D' if it is disabled), Orbit type (always a 'A' for a asteroid), Epoch, Year, Month, Date, Mean
Anomaly, Semi-Major Axis,  Eccentricity,   Argument of Perihelion, Longitude of Ascending Node,  Inclination,
Magnitude Parameter 'H', and Magnitude Parameter 'G'.  For a description of each entry, see section 3.3.5.

3.1.10 Save Orbits

The  Save Orbits... menu selection is used to save the orbital information for comets and asteroids.  It
presents a dialog box allowing an orbital data file to be entered, then subsequently saved.  It defaults to file names



with the extension ".orb".  

The format of the file saved is specific to  ECU, but is in ASCII format, thus can be altered by any text
editor, such as the Windows Notepad.  All 50 comets and asteroids are saved in the file format  described in section
3.1.9.

3.1.11 Exit

The Exit menu selection is used to exit ECU.  If the configuration settings have changed, a message box
appears asking to user to specify if the settings are to be saved to the current file name.  Pressing "Yes" (or the enter
key) will save the configuration settings to the current file name and exit  ECU.   Pressing "No" will exit  ECU
without saving the configuration settings.  Pressing "Cancel" will return control to ECU.

ECU can also be exited by "double-clicking" on the Control-menu box or by selecting "Close" in the
window's system menu.  The keyboard equivalent to this menu selection is Alt-E or Alt-F4.  

3.2 Edit Menu

The Edit menu currently has only one entry: Undo.  The Undo menu selection nullifies the last operation.
This is very useful when you have made a "slip of the mouse" and wish to get back to where you were.  The
keyboard equivalent to this menu selection is Alt-Backspace.

3.3 Set Menu

The  Set menu  allows  the  time,  geographic  location,  Solar  System  calculation  settings,  atmospheric
refraction setting, comet and asteroid orbits, sky colours, and sky drawing mode to be adjusted.  Each is described in
the sections below.

3.3.1 Time

The time can be set in one of three formats: local civil time, Universal time (UTC), set to your pc's system
clock (using local civil time).  The current time format used is identified in the Time menu selections sub-menu, by
a check mark in front of the current mode.  The following sections describe the time settings.

3.3.1.1 Enter Local Time

The Enter Local Time menu selection presents a dialog box allowing the user to enter the year, month,
date, hour, and minute in local time format.  The year can be from 4713BC to 9999 AD and the hour must be in 24
hour format.  There is a year 0, so example if the proper year 6 BC is to be entered, -5 should be used for the year.
The time is always initialized to the current time.  

Ending the dialog box is accomplished by pressing the 'OK' button.  Aborting, without changing the time, is
accomplished by pressing 'Cancel'.  If an error is detected when ending the dialog box, a 'beep' will sound and the
cursor will be placed at the offending field.

This menu selection can also be activated by pressing the left mouse button while the mouse is in either of
the boxes which display the local  mean date and time (LMT) in the  ECU status  display area.   The keyboard



equivalent to this menu selection is Alt-T.

3.3.1.2 Enter Universal Time

Entering the Universal time is accomplished identically to entering the local time.  This menu selection can
also be activated by pressing the left mouse button while the mouse is in either of the boxes whic
h display the universal date and time (UTC) in the ECU status display area.

3.3.1.3 Use System Time

Selecting Use System Time causes ECU's local time to become synched to your pc's system clock.  This
will cause the sky to update automatically once per minute, therefore simulating the actual sky's movements.  The
keyboard equivalent to this menu selection is Alt-U.

3.3.1.4 Set Time to System Time

Selecting Set Time to System Time causes ECU's time base to be set to your pc's system clock.  Unlike
the selection Use System Time, the sky will not update automatically thereafter.  The keyboard equivalent to this
menu selection is Alt-N (N stands for NOW!).

3.3.1.5 Local Time Format

The local mean time (LMT) display in the status area is displayed in either 24 hour or am/pm format.  The
Local Time Format menu selection is a sub-menu of AM/PM and 24 Hour selections, each selection setting the
respective format.  The current format is identified by a 'check mark'.

3.3.1.6 Daylight Savings

The  Daylight Savings menu selection toggles  whether  the current local  time is  to  be interpreted as  a
daylight savings time.  It is used by ECU to convert from local time to Universal time.  If a 'check mark' is present,
daylight savings mode is enabled.  If ECU is using the pc's system clock and the daylight savings time 'check mark'
is present, the pc's time should be set to the daylight savings time.

3.3.2 Geographic Location

The  Geographic Location menu selection provides  a sub-menu containing two methods of entering a
location on the Earth's surface.  These are By Latitude/Longitude and By City/Town.

3.3.2.1 By Latitude/Longitude

The By Latitude/Longitude menu selection presents a dialog box allowing the user to enter the latitude,
longitude, and time zone of the location used in the sky display calculations.  The latitude is entered as degrees
(North is positive, South is negative) and minutes.  The longitude is also entered as degrees (West of the prime
meridian is positive, East is negative) and minutes.  The time zone is entered in hours West of UTC (the time of the



Greenwich meridian; enter a negative for the Eastern hemisphere).  The location is always initialized to the current
location.  

Ending the  dialog box is  accomplished  by  pressing  the  'OK'  button.   Aborting,  without  changing  the
location, is accomplished by pressing 'Cancel'.  If an error is detected when ending the dialog box, a 'beep' will
sound and the cursor will be placed at the offending field.

This menu selection can also be activated by pressing the left mouse button while the mouse is in either of
the boxes which display the current latitude and longitude in the ECU status display area. The keyboard equivalent
to this menu selection is Alt-L.

3.3.2.2 By City/Town

The By City/Town menu selection presents a dialog box allowing the user to select the location from a set
of pre-defined locations.  A list box is presented containing the available list.  The user is to select the desired
location, then exit the dialog box.

Ending the  dialog box is  accomplished  by  pressing  the  'OK'  button.   Aborting,  without  changing  the
location, is accomplished by pressing 'Cancel'.

This menu selection can also be activated by pressing the left mouse button while the mouse is in the box
which displays the current city/town at the top the ECU status display area.  The keyboard equivalent to this menu
selection is Alt-C.

If your location is not in the list of available locations, you can use a text editor (the Windows NotePad
will do fine) to edit the file LOCATION.ECU.  The file format is quite simple, as shown by the sample entries
below:

44.58 63.65 4 Halifax NS
47.83 71.25 5 Quebec QUE
43.65 79.38 5 Toronto ONT
42 83 5 Windsor ONT
51.50 0.17 0 London UK

The first  three  entries,  which  are  separated  by  spaces,  are  the  latitude  (decimal  degrees  North  of  the
Equator), longitude (decimal degrees West of the Prime meridian), and time zone (hours West of UTC).  The fourth
entry is the name of the location. 

3.3.3 Solar System

The Solar System menu selection provides a sub-menu allowing several calculation options pertaining to
the Solar System to be changed.  A 'check mark' in front of a menu item indicates that it is enabled.  Each menu item
is described below.

For maximum accuracy, set all check marks to their checked state.  This is very important when simulating
eclipses or other astronomical phenomenon where the observer's geographic location is important.

3.3.3.1 High Accuracy Calculations

This menu selection controls the precision of  the solar  system calculations.   When checked,  positions



reported are generally accurate to a few arc-seconds or better. 

3.3.3.2 Precess to Sky Display

This menu selection controls whether the Solar System object positions and the horizon line are to be
adjusted (due to the effect of precession of the Earth's axis of rotation) to match the J2000.0 coordinates used by the
sky display.

3.3.3.3 Nutation

This menu selection controls whether the Solar System object positions (except for comets and asteroids)
are to be corrected for the effects of Nutation.  Nutation is at maximum, a 9 arc-second wobble in the precession
circle primarily caused by the gravitational pull of the Moon.

Nutation can only be calculated when the High Accuracy Calculations selection is enabled. 

3.3.3.4 Aberration

This menu selection controls whether the Solar System object positions (except for comets and asteroids)
are to be corrected for the effects of Aberration.  Aberration is the apparent displacement of the position of an object
due to the finite speed of light.  This effect is due to the rotation of the Earth and the motion of the Earth through the
solar system.

The effect of Aberration can only be calculated when the High Accuracy Calculations selection is enabled. 

3.3.3.5 Light Travel Time

This  menu selection  controls  whether  the  Solar  System object  positions  (except  the  Moon)  are  to  be
corrected for the effects of the Light Travel Time.  The Light Travel Time correction recognizes that the observer
sees an object at where it used to be in the past.

Light Travel Time corrections can only be calculated when the High Accuracy Calculations selection is
enabled. 

3.3.3.6 Observer's Parallax

This menu selection controls whether the Solar System object positions (except for comets and asteroids)
are to be corrected for the effects of the Observer's Parallax.  The Observer's Parallax is the effect of an apparent
shift of an objects position for observers located at different locations on the Earth.  This effect is what causes the
Solar Eclipses and Occultations of the Moon to be only observable from certain locations on the Earth's surface.  

It  is  very important  that  this selected be enabled when simulating solar eclipses  or other astronomical
phenomenon where the observer's geographic location is important.

3.3.4 Atmospheric Refraction



This  menu  selection  controls  whether  the  local  horizon,  Azimuth  and  Altitude  displays,  and  Rise/Set
calculations are to be corrected for the effects of Atmospheric Refraction.  Atmospheric Refraction causes an object
to appear higher in the sky that it actually is.  The bending (or refraction) of light as it passes through the Earth's
atmosphere causes this effect.

3.3.5 Define Orbit

The Define Orbit... menu selection presents a dialog box allowing the user to select one of the 50 comets
or asteroids whose orbit you wish to change or define.  If the comet or asteroid has already been named, it name will
be shown, otherwise its number will be shown.  Select the desired comet or asteroid and press 'OK' or press 'Cancel'
to abort the dialog box. 

When a comet or asteroid is selected, a second dialog box is presented allowing the orbital elements of a
comet or asteroid to be entered or changed.  The following items can be entered.

a) Orbit Type - select the type of orbit to be used; either comet or asteroid.
b) Comet or Asteroid Name - a textual name that can be displayed next to the comet or asteroid in the sky

display.
c) Date of Perihelion or Date of Epoch - if the orbit type is 'comet', the date of perihelion is to be entered

here.  If the orbit type is 'asteroid', then the date of the epoch is to be entered here.  The date is entered as
either decimal years or as year, month, and decimal days.  If the month is set to zero, the decimal years are
used and the month and date are ignored.  If the month is valid (1 to 12), the year, month, and date are used.

d) Mean Anomaly (M) - angle of an asteroid at the epoch in degrees.  Not used for comet orbits. 
e) Perihelion Distance (q) or Semi-major Axis (a) - the distance of the comet from the Sun in astronomical

units (AU) at Perihelion or the semi-major axis of the asteroidal orbit in AU.
f) Eccentricity (e) - the eccentricity of the orbit from 0 to 2.
g) Argument of Perihelion () - the argument, in degrees, of the perihelion.
h) Longitude of Ascending Node () - the longitude, in degrees, of the ascending node.
i) Inclination of Orbit (i) - the inclination of the orbit in degrees.
j) Epoch of the Elements - the epoch of the elements, either B1950.0 or J2000.0.
k) Magnitude Constants - the magnitude constants H and G, are used to estimate the brightness of the comet

or asteroid.  Each comet or asteroid has a different set of constants.  Comet brightness predictions are
notoriously extremely unreliable.

l) Enable Orbit - this flag enables the orbit for display.

Ending the dialog box is accomplished by pressing the 'OK' button.  Aborting, without changing the comet
orbital elements, is accomplished by pressing 'Cancel'.

If a comet has a name and is 'enabled',  it will be subsequently be referred to by its name instead of just
"Comet/Asteroid 1", etc. 

3.3.6 Set Sky Colours

The Set Sky Colours... menu selection presents a dialog box allowing the user to set the colours used to
draw the sky display.  The dialog box contains four "radio" buttons, one "combo" box, and three scroll bars.  When
drawing the sky display ECU subdivides the drawing into 26 different elements.  These include elements such as
constellation lines, the sun, galaxies, etc.  

The radio buttons are mutually exclusive, such that only one can be active at any one time.  The "Colour"
radio button is the mode where the colour of each sky display drawing element can be individually set as described
below.  The "White on Black Background" mode causes the entire sky display to be drawn in white with a black



background.  The "Black on White Background" mode causes the entire sky display to be drawn in black with a
white background.  This mode is especially useful for "pasting" the display into other Windows program for further
manipulation.  Either of these two modes may also be useful when ECU is used on laptop computers with LCD
screens.  

The  "Red"  mode  causes  the  entire  screen  (including  the  system  colours,  which  will  affect  all  other
Windows applications running on your system) to appear in black and shades of red.  When ECU is being used in
the field or in an observatory, this mode will help maintain the user's dark adaptation.  When exiting ECU, all of the
system colours are restored to their original state.

The colours of individual sky display drawing elements are controlled by first selecting the element from
the "drop down pick list" in the top left of the dialog box.  Pressing the down arrow will cause a "pick list" to be
displayed with a scroll bar on the right hand side.  Using the scroll bar, simply select the drawing element whose
colour you wish to change with the mouse.  The three horizontal scroll bars on the right side of the dialog box will
be set to the colour of the selected drawing element and the actual colour is shown in a box beneath the scroll bars.  

In Windows, colours are represented by their equivalent red, green, and blue proportions.  To change a
colour drag any or all of the three scroll bars until the desired colour is shown.  The number of different colours that
can be produced varies considerably (ranging from 16 to about 16 million colours) with the graphics card and its
associated driver program.

Pressing 'OK' exits the dialog box and activates the new colour settings.  Pressing 'Cancel' exits without
making any changes.

3.3.7 Set Drawing Mode

The Sky Drawing Mode menu selection provides a sub-menu allowing the mode in which ECU uses to
draw the sky display.  If 'Fast Update' is selected, the sky display will update essentially instantaneously.  ECU
performs all the necessary calculations and drawing functions to the computer's memory in advance, then updates
the sky display all at once.  The is the best mode to use with the animation functions described in section 3.6.

If 'Continuous Drawing' is selected, the sky display will update sequentially as each element is calculated
and  drawn.   This  mode  may  enable  the  sky  display  to  update  faster  than  the  'Fast  Update'  mode  on  some
"accelerated" graphics boards that have become very popular lately.  A 'check mark' marks the current setting.

3.4 Field Menu

The  Field menu  controls  various  parameters  pertaining  to  the  sky  display.   Each  menu  selection  is
described separately in the following sections.

3.4.1 Display

The Display menu selection provides a sub-menu allowing the user to toggle the display of stars, deep sky
objects, solar system objects, the grid lines, lines and labels on the sky display.  This menu selection duplicates the
on-screen check boxes.  The current state of each display setting indicated by a 'check mark' in front of the menu
item.

3.4.2 Magnitude Limits



The  Magnitude  Limits... menu  selection  presents  a  dialog  box  allowing the  user  to  set  the  limiting
magnitude  for  stellar  and  deep  sky  objects.   The  magnitude  is  set  by  dragging  the  scroll  bars  to  the  desired
magnitude as displayed immediately below each scroll bar.

The actual stellar limiting magnitude depends state of the "Auto Stellar Limit" check box.  If "checked", the
stellar limit depends on the field size, however, the scroll bar sets the upper limit.  

If not "checked", all stars in the database are drawn up the limit set on the scroll bar.  However, if the field
size is greater than 45 degrees, then only the Yale stars are shown (to magnitude 6.5).  The negative side effects of
this mode are that the sky display may take longer to re-draw (due to many more stars being drawn) and the stars
cannot be identified with the mouse.  

If the deep sky magnitude limit is set to 20, all objects will be displayed, even those whose magnitude is
unknown.

Pressing 'OK' exits the dialog box and activates the new magnitude limits.  Pressing 'Cancel' exits without
making any changes.

 This menu selection can also be activated by pressing the left mouse button while the mouse is in box
which displays the current Magnitude Limit in the ECU status display area.

3.4.3 Object Selection

The  Object Selection... menu selection presents a dialog box allowing the user to select which types of
deep sky objects are displayed.  The dialog box has 7 check boxes; one for each of Galaxies, Globular Clusters,
Open Clusters,  Bright Nebulae,  Planetary Nebulae,  Other,  and Unknown Magnitudes.   If  the check box of  the
respective object type is true, that type will be displayed (if deep sky objects are also 'turned on').

Note that  the 'Unknown Magnitude'  type is provided to  allow the user  to 'turn off'  the objects  whose
magnitude is unknown.  This makes the display less cluttered by not displaying hundreds (or thousands) of objects
that are likely to be quite faint.

Pressing 'OK' exits the dialog box and activates the new object selections.  Pressing 'Cancel' exits without
making any changes.

3.4.4 Planets

The  Planets... menu selection  presents  a  dialog  box which  allows the  user  to  control  various  display
parameters for the eight planets.  

The three entries for each planet include a check box indicating if the respective planet is displayed, a set of
radio buttons which determines if it is displayed as either a point or as the plane
t's symbol (planet symbols are not drawn to printed charts), and a check box indicating if the planet's name is also
displayed.

Pressing 'OK' exits the dialog box and activates the new planets settings.  Pressing 'Cancel' exits without
making any changes.

3.4.5 Sun



The Sun menu selection toggles whether or not the Sun is displayed on the sky display.  If marked by a
'check mark', the Sun will be displayed (assuming the Solar System objects are also 'turned on').

3.4.6 Moon

The Moon menu selection toggles whether or not the Moon is displayed on the sky display.  If marked by a
'check mark', the Moon will be displayed (assuming the Solar System objects are also 'turned on').

3.4.7 Grid

The Grid menu selection provides a sub-menu allowing the resolution of the coordinate grid to be set.  If
'Fine' is selected, the grid will mark every 20 minutes in Right Ascension and every 5 degrees in Declination.  If
'Coarse' is selected, the grid will mark every 1 hour in Right Ascension and every 10 degrees in Declination.  A
'check mark' marks the current setting.

3.4.8 Lines/Points

The Lines/Points menu selection provides a sub-menu allowing the user to toggle the display of lines and
points on the sky display.  These include the constellation lines, constellation boundary lines, ecliptic line, horizon
line, zenith point, and celestial pole points.  The current state of each line/point is indicated by a 'check mark' in
front of the menu item.

3.4.9 Labels

The Labels menu selection provides a sub-menu allowing the user to toggle the display of text labels on the
sky display.  These include the constellation labels, bright star labels, Solar System labels, Messier labels, horizon
line/zenith point labels (N,S,E,W, etc.), and ecliptic point labels (VE - vernal equinox, SS - summer solstice, etc.).

An additional selection labeled "Draw Labels When Zoomed Out" controls whether the major labels are
displayed when the field size is larger than 60 degrees in height.  The purpose of this selection is to reduce the text
"clutter" when "zoomed out", while maintaining the desired detail when "zoomed in".  

The current state of each label is indicated by a 'check mark' in front of the menu item. 

3.4.10 Scroll Bars

The Scroll Bars menu selection provides a sub-menu allowing the mode of the scroll bars to be set.  If
'RA/Dec'  is  selected,  the  scroll  bars  are  used  to  move  about  the  celestial  sphere  using  Right  Ascension  and
Declination coordinates.  If 'Azim/Alt' is selected, the scroll bars are used to move about the local sky display using
Azimuth and Altitude coordinates.  A 'check mark' marks the current setting.

3.4.11 Telescope Field

The Telescope Field menu selection provides a sub-menu allowing "field of view" circles and rectangle to
be controlled.  It also provides access to the Flip Horizontal and Flip Vertical menu selections.



3.4.11.1 Set Field of View

The Set Field of View... menu selection presents a dialog box allowing the user to enable and control the
angular size of two circular and one rectangular field of view indicator drawn on the sky display.

The field of view indicators are useful for showing the angular size on the sky observed in a telescope using
a particular eyepiece, or viewed by your photographic or CCD camera.  The default values of 1 and 4 degrees
closely match average low power eyepiece and finder scope fields respectively.

These values are easy to determine for your telescope and eyepiece combination without knowing the focal
length of your telescope or the parameters of your eyepiece.  Simply position a star located within a few degrees of
the equator near the east side of your eyepiece and time, in seconds, how long it takes to cross the field.  Make sure
your clock drive is turned off.  The field size, in degrees, is:

0.004166 * time(s)

Values can be entered from 0.05 to 10 degrees for either the two circular of one rectangular fields of view.
Each field of view can be individually enabled by "checking" the "Enable" check box.

Pressing 'OK' exits the dialog box and activates the field of view settings.  Pressing 'Cancel' exits without
making any changes.

3.4.11.2 Flip Horizontal

The  Flip Horizontal menu selection toggles whether or not the sky display is drawn as a mirror image
(flipped left to right).  If marked by a 'check mark', the sky display will be flipped.  This selection is useful by itself
to simulate what the sky will look like though a telescope which produces an upright, but reversed image such as a
refractor or Schmidt-Cassegrain with a star diagonal installed.  Used in conjunction with  Flip Vertical, the sky
display is drawn upside-down and reversed left to right, to simulate the view though an Newtonian telescope or to
make the sky appear more realistic to those user's located in the Earth's southern hemisphere.

3.4.11.3 Flip Vertical

The Flip Vertical menu selection toggles whether or not the sky display is drawn as a upside-down (flipped
top to bottom).  If marked by a 'check mark', the sky display will be flipped.  If this selection is used in conjunction
with Flip Horizontal, the sky display is drawn upside-down and reversed left to right, to simulate the view though
an Newtonian telescope or to make the sky appear more realistic to those user's located in the Earth's southern
hemisphere.

3.4.12 Field Size

The  Field Size... menu selection presents  a  dialog box allowing the user  to enter  the vertical  size,  in
degrees, of the ECU sky display.  The valid range is 2 to 180 degrees in integer divisions. 

Ending  the  dialog  box  is  accomplished  by  pressing  the  'OK'  button.   Aborting,  without  changing,  is
accomplished by pressing 'Cancel'.  If an error is detected when ending the dialog box, a 'beep' will sound and the
cursor will be placed at the offending field.



 This menu selection can also be activated by pressing the left mouse button while the mouse is in box
which displays the current Field Size in the ECU status display area.

3.4.13 Zoom In Full

The Zoom In Full menu selection causes the ECU sky display to zoom in to the minimum allowable field
size, which is 2 degrees in height.  The keyboard equivalent to Zoom In Full is Alt-Z.

3.4.14 Zoom To 15 Degrees

The Zoom To 15 Degrees menu selection causes the ECU sky display to zoom a field size, which is 15
degrees in height.

3.4.15 Zoom To 45 Degrees

The Zoom To 45 Degrees menu selection causes the ECU sky display to zoom a field size, which is 45
degrees in height.

3.4.16 Zoom To 90 Degrees

The Zoom To 90 Degrees menu selection causes the ECU sky display to zoom a field size, which is 90
degrees in height.

3.4.17 Zoom Out Full

The Zoom Out Full menu selection causes the ECU sky display to zoom out to the maximum allowable
field size, which is 180 degrees in height.  The keyboard equivalent to Zoom Out Full is Alt-Z.

3.5 Center Menu

The  Center menu allows the user to quickly center on most objects in  ECU's databases.  This includes
centering on a specified Right Ascension/Declination, a specified Azimuth/Altitude, a constellation, a bright star,
Messier object, Solar System object, a point on the local horizon, or on a text search of the databases.  When an
object is centered on the sky display, a cross-hair is used to mark it.  Each centering menu selection is described
separately below.

3.5.1 On RA/Dec...

The On RA/Dec... menu selection presents a dialog box allowing the user enter a specific Right Ascension
and Declination to center the sky display on.  The Right Ascension is entered as hours and minutes.  The Declination
is entered as degrees and minutes. 

Ending the dialog box is accomplished by pressing the 'OK' button.  Aborting, without changing the sky
display, is accomplished by pressing 'Cancel'.  If an error is detected when ending the dialog box, a 'beep' will sound



and the cursor will be placed at the offending field.

When the dialog box ends,  ECU centers the sky display at the coordinates entered.  This menu selection
can also be activated by pressing the left mouse button 
while the mouse is in either of the boxes which display the current Right Ascension/Declination in the ECU status
display area.

3.5.2 On Az/Alt...

The  On Az/Alt... menu selection presents a dialog box allowing the user enter a specific Azimuth and
Altitude, with reference to the local horizon, to center the sky display on.  Both the Azimuth and Altitude are entered
as degrees and minutes. 

Ending the dialog box is accomplished by pressing the 'OK' button.  Aborting, without changing the sky
display, is accomplished by pressing 'Cancel'.  If an error is detected when ending the dialog box, a 'beep' will sound
and the cursor will be placed at the offending field.

When the dialog box ends,  ECU centers the sky display at the local horizon coordinates entered.  This
menu selection can also be activated by pressing the left mouse button while the mouse is in either of the boxes
which display the current Azimuth/Altitude in the ECU status display area.

3.5.3 On Constellation...

The On Constellation... menu selection presents a dialog box allowing the user to select a constellation to
center the sky display on.  A list box is presented containing the available list of 88 constellations in alphabetical
order.  The user is to select the desired constellation, then exit the dialog box.  ECU then centers the sky display on
the selected constellation.

3.5.4 On Bright Star...

The  On Bright Star... menu selection presents a dialog box allowing the user to select a bright star to
center the sky display on.  A list box is presented containing the available list of bright stars in alphabetical order.
The user is to select the desired bright star, then exit the dialog box.  ECU then centers the sky display on the
selected bright star.

3.5.5 On Messier Object...

The  On Messier Object... menu selection presents a dialog box allowing the user to select  a Messier
Object to center the sky display on.  A list box is presented containing the available list of 110 Messier objects in
numerical order.  The user is to select the desired object, then exit the dialog box.  ECU then centers the sky display
on the selected Messier object.

3.5.6 On Solar System Object

The On Solar System Object menu selection contains a sub-menu of all the Solar System objects (Sun,
Moon, Planets, and Comets).  The menu item selected is centered on the sky display.  The keyboard equivalent to
center on the Moon is Shift-M, and to center on the Sun is Shift-S.



3.5.7 On Point on Horizon

The  On Point on Horizon menu selection contains a sub-menu of all the cardinal points on the local
horizon plus the Zenith (the overhead point).  The menu item selected becomes centered on the sky display.  There
are several keyboard equivalents for these menu selections; see section 2.5.

3.5.8 On Database Search

The On Database Search... menu selection is used to search the ECU databases for a specified object.  If a
match is found, the specified object is centered on the sky display.  The user is presented with a dialog box which
prompts  for  a  line  of  text.   If  the  'OK'  button is  pressed,  the search  commences.   The line  of  text  entered is
immediately converted to upper case to avoid ambiguities and all spaces are removed.  The object types which can
be searched for are listed below:

a) Constellations - the 88 constellations can be searched by entering their complete formal name (eg. 'Ursa
Major').

b) Bright Stars - bright stars can be searched by entering their complete formal name (eg. 'Deneb').
c) Stars - any star in the Yale Bright Star (YBSC) database can be searched by entering either its Smithsonian

Astrophysical Observatory (SAO) catalogue number with the prefix 'SAO', its Yale number with the prefix
'HR', or its Henry Draper (HD) catalogue number with the prefix 'HD'.  For example, to find the SAO star
number 49898, enter 'SAO49898'.  Note that entering 'sao  49898' would be just as effective because the
case of the input and spaces are ignored.  This search is limited to searches of stars in the Yale Bright Star
Catalogue database.  SAO stars which are fainter than 6.5 magnitude (the extended stellar database) are not
searched, primary due to the excessive time that it would take to search the entire SAO database of about
250,000 stars.

d) Deep Sky Objects - deep sky objects can be searched by entering either their primary name or 'Other
Names:' as stored in the SAC deep sky database (see Section 4.).  For example, the Andromeda Galaxy can
be found by entering either its official name 'NGC224' or its common name (other name) 'M31'.

If the search is not successful, a message box will appear informing the user of this.

3.6 Animation Menu

The Animation menu controls all of the functions of ECU's animation mode.  The animation mode is used
to simulate astronomical events which are affected by changes in the time.  The animation mode has the following
features.

a) Time can be automatically stepped in any step from 1 minute to 4 years or any arbitrary number of minutes,
hours, days, or years.

b) Time can be stepped in either forward or reverse.
c) The time between time steps can be set from 0 to 60 seconds.
d) The trail history can be stored as either the objects Right Ascension/Declination or its Azimuth/Altitude.
e) The solar system objects can be trailed with dots drawn behind them.
f) The number of dots used in the trail can be set from 10 to 100.
g) The sky display can be made to 'lock'  on any solar system object,  or point with reference to the local

horizon.
h) The time can be manually stepped, either forward or in reverse.
i) All of the features of ECU can be used while the animation mode is running due to the multi-tasking nature

of Windows, and thus of ECU.



Animation mode is best learned by experimentation, however, the menu items which control the animation
mode are described in the sections below.  When using the animation mode, the sky display updates may "flicker",
unless the 'Sky Drawing Mode' is set to 'Fast Update' (see Section 3.3.7).

3.6.1 Start

The  Start menu selection starts  the  animation mode.   If  a  'check  mark'  precedes the menu selection,
animation mode is running.

3.6.2 Stop

The Stop menu selection stops the animation mode.  The ESC key can also be used to stop the animation
mode.

3.6.3 Forward One Step

The Forward One Step menu selection steps the time forward by one time step.  The time step is displayed
to the left of the time step buttons in the status area.  This menu selection can also be executed by pressing the '+'
key or the '+' button.

3.6.4 Reverse One Step

The  Reverse One Step menu selection steps the time in reverse by one time step.   The time step is
displayed to the left of the time step buttons in the status area.  This menu selection can also be executed by pressing
the '-' key or the '-' button.

3.6.5 Trails On

The  Trails  On menu selection  enables  the  drawing of  trails  (small  crosses)  behind the  Solar  System
objects.  If the trails are enabled, a 'check mark' will precede this menu selection.

3.6.6 Maximum Trails

The  Maximum Trails... menu selection presents a dialog box allowing the user to enter the number of
trails (10 to 100) to be drawn behind Solar System Objects. 

Ending  the  dialog  box  is  accomplished  by  pressing  the  'OK'  button.   Aborting,  without  changing,  is
accomplished by pressing 'Cancel'.  If an error is detected when ending the dialog box, a 'beep' will sound and the
cursor will be placed at the offending field.

3.6.7 Animation History

The  Animation History menu selection presents a sub-menu of the selections:  RA/Dec and  Anim/Alt.



These selections control whether the animation history (the previous positions) is saved as the Right Ascension and
Declination of the object or as its Azimuth and Altitude with reference to the local horizon.  The latter setting is
useful for observing an object's path relative to the local horizon.  A good example of this would be to plot the
positions of the planet Mercury as it passes through an eastern or western elongation and becomes visible in the
evening or morning sk
y.  Beware, however, that the actual positions shown in the object trails (except for the current position) are  not
correct with reference to the background stars for the time shown.  Also, this setting operates slowly, because the
computational overhead is higher.  A 'check mark' will immediately precede current setting.  For normal use, ensure
that this setting is set to RA/Dec.

3.6.8 Lock On Current RA/Dec

The  Lock On Current RA/Dec menu selection causes the animation mode to be locked on the current
Right Ascension and Declination.  In fact, it turns 'lock mode' off.  If locked on the current RA/Dec, a 'check mark'
will immediately precede this menu selection.

3.6.9 Lock On Current Azim/Alt

The Lock On Current Azim/Alt menu selection causes the animation mode to be locked on the current
altitude and azimuth, with respect to the local horizon.  This feature is very useful for 'watching' a particular horizon
as the constellations rise or set, or as a planet such as Mercury crests above the horizon.  If locked on the current
Azim/Alt, a 'check mark' will immediately precede this menu selection.

3.6.10 Lock On Solar System Object

The Lock On Solar System Object menu selection presents a sub-menu of all the Solar System objects
(Sun, Moon, Planets, and Comets).  The menu item selected becomes locked to the center of the sky display in
animation mode.  A 'check mark' will immediately precede the Solar System object locked.

3.6.11 Time Direction

The Time Direction menu selection presents a sub-menu of the selections: Forward and Reverse.  These
selections control the direction in which time is stepped when the animation mode is running.  A 'check mark' will
immediately precede the time direction setting.

3.6.12 Time Step

The  Time Step menu selection  presents  a  sub-menu of  the  selections:  Enter Time Step...,  Increase,
Decrease and Step: x Hours.   The Enter Time Step... menu selection presents a dialog box allowing the user enter
an arbitrary time step.  The user is to enter the desired step size as a number (decimals are allowed).  The unit of
time (minutes, hours, days, or years) used is selected by pressing the appropriate 'radio button'. Ending the dialog
box is accomplished by pressing the 'OK' button.  Aborting, without changing, is accomplished by pressing 'Cancel'.
If an error is detected when ending the dialog box, a 'beep' will sound and the cursor will be placed at the offending
field.  This dialog box can also be selected by clicking the mouse over the area where the time step is displayed (to
the right of the time step arrows) in the status area.

The next two selections Increase or Decrease, by one notch, the amount of the animation mode time step.



The current time step is shown as the fourth sub-menu item.  These two selections are duplicates of the time step
arrows in the status area.

The last selection cannot be selected, but rather, displays the current value of the time step in minutes,
hours, days, months, or years.
 

3.6.13 Animation Speed

The  Animation Speed... menu selection presents  a  dialog box allowing the  user  enter  the number  of
seconds between animation mode updates (0 to 60 seconds). 

Ending  the  dialog  box  is  accomplished  by  pressing  the  'OK'  button.   Aborting,  without  changing,  is
accomplished by pressing 'Cancel'.  If an error is detected when ending the dialog box, a 'beep' will sound and the
cursor will be placed at the offending field.

3.7 Miscellaneous

The Miscellaneous menu provides access to all of the functions which did not seem belong anywhere else!
These include all of the telescope functions.

3.7.1 Sun and Moon Data

The Sun and Moon Data... menu selection presents a dialog box which displays various data for the Sun
and Moon on the current date.  An example dialog box is shown below.  

Civil, nautical, and astronomical twilight are defined as when the Sun is 6, 12, and 18 degrees below the
local  horizon,  respectively.   These  twilight  times  can  be  used  to  determine  when  it  is  dark  enough  to  begin
observing; usually between the times of nautical and astronomical twilight for deep sky observing.  

Ending the dialog box is accomplished by pressing the 'OK' button.

3.7.2 Julian Date/Sidereal Time

The Julian Date/Sidereal Time... menu selection presents a dialog box which displays the current Julian
Date and Local Sidereal Time.   Ending the dialog box is accomplished by pressing the 'OK' button.

3.7.3 Telescope

The Telescope menu selection presents a sub-menu which provides access to all of the telescope functions
provided by ECU.  After changing any of the settings in the Telescope sub-menu, remember to use the "Save" or
"Save As..." function to make these settings permanent.

This section of the manual will only serve as a reference for the telescope menu selections.  See section 6
for detailed operating instructions for the telescope functions. 

3.7.3.1 Enable Meade LX200



The  Enable  Meade  LX200 menu selection  initiates  communication  with  the  Meade  LX200  or  LXD
computerized telescope drive connected to your computer's RS232 port (see section 3.7.3.11 for port selection).  

If an error occurs during this process, a message box will appear on the screen explaining the error.  The
first possible error will occur if ECU cannot open the communications port.  If this error occurs, make sure that you
have selected a port that exists and is not in use by another program running on your system (perhaps the mouse).
The second possible error occurs if ECU cannot communicate with the telescope.  If this error occurs, make sure the
telescope is turned on, initialized according to your Meade instruction manual, and is properly connected to your
computer.

If successful, the Meade telescope system will be active as indicated by the check mark next to this menu
item.  Depending on other settings described below, one or two windows may appear on the sky display and a cross-
hair may be drawn to show the current location of the telescope in the sky.

To disable the Meade telescope functions, select this menu item again.

3.7.3.2 Enable/Align Encoder Interface

The  Enable/Align  Encoder  Interface menu  selection  activates  the  optical  encoder  interface  system
connected to your computer's RS232 port (see section 3.7.3.11 for port selection).

When activated for the first time since running ECU, your telescope will have to be aligned by pointing it
at  one  or  two known stars  following the  on-screen  messages.   If  activating  this  menu item after  it  has  been
previously aligned,  you  will  be  given  the  option to  use  your  previous  alignment.   The  specific  details  of  the
alignment process is covered step-by-step in section 6.2

If an error occurs during this process, a message box will appear on the screen explaining the error.  The
first possible error will occur if ECU cannot open the communications port.  If this error occurs, make sure that you
have selected a port that exists and is not in use by another program running on your system (perhaps the mouse).
The second possible error occurs if ECU cannot communicate with the encoder interface.  If this error occurs, make
sure the encoder interface is turned on and is properly connected to your computer.

If successful, the optical encoder interface system will be active as indicated by the 'check mark' preceding
this menu item.  Depending on other settings described below, a windows may appear on the sky display and a
cross-hair may be drawn to show the current location of the telescope in the sky.

To disable the encoder interface functions, select this menu item again.

3.7.3.3 Show Position

The Show Position menu selection is a toggle which determines if a cross-hair is drawn on the screen to
track the current position of the telescope in the sky.  If active, a 'check mark' will immediately precede this menu
selection.

This menu selection is valid when using either the Meade telescope system or the encoder interface system.

3.7.3.4 Show Coordinates

The Show Position menu selection is a toggle which determines if the current position o



f the telescope (in right ascension and declination)  is displayed on the screen.  The position is displayed in a
window (shown below) that is always positioned at the lower left corner of the sky display.  It can, however, be
moved by the user.  If active, a 'check mark' will immediately precede this menu selection.

This menu selection is valid when using either the Meade telescope system or the encoder interface system.

3.7.3.5 Track Telescope

The Track Telescope menu selection is a toggle which determines if the sky display is to track the current
position of the telescope.  If active, and the telescope position cross-hair (see section 3.7.3.3) moves out of the sky
display, it will be re drawn with the current telescope position at the center of the sky display.

If active, a 'check mark' will immediately precede this menu selection.  This menu selection is valid when
using either the Meade telescope system or the encoder interface system.

3.7.3.6 LX200 Control

The  LX200 Control menu selection is  a  toggle which determines if  the dialog box used to manually
control the motion and focus position of the Meade telescope system is displayed.  The dialog box is always initially
positioned at the lower right corner of the sky display.  It can, however, be moved by the user.  

The first  item in the dialog box (shown below) is labeled "Pulse".   If  "checked", pressing any of the
direction buttons ("N", "S", "E", or "W" meaning north, south, east, and west) will cause a brief, but consistent
movement in the direction pressed.  If not checked and a direction button is pressed, the telescope will move until
the same direction button is pressed again.

Six "radio buttons" are used to select the speed at which the telescope moves or the focus motor speed.  The
first four: "Slew", "Find", "Center", and "Guide" control the speed at which the telescope moves, ranging from 8º
per second in Slew mode to 15 arc-seconds per second in Guide (consult your Meade instruction manual for details).

The other two buttons, labeled "Focus S" and "Focus F" mean "focus slow" and "focus fast".  When either
of these two buttons are pressed, the "N" and "S" buttons are replaced with "O" and "I" buttons.  "O" and "I"
represent "focus out" and "focus in" respectively.

To move the telescope,  simply press  the button to select  the desired speed and then press  the desired
direction button; for example "N".  If "Pulse" was "checked", the telescope will move briefly north, otherwise the
"N" button will change to a "<N>" indicating that it is active.  Pressing "N" again will stop the telescope motion.

To focus the telescope, simply press the button to select the desired focus speed and then press the desired
direction button; for example "O".  If "Pulse" was "checked", the focus will move briefly out, otherwise the "O"
button will change to a "<O>" indicating that it is active.  Pressing "<O>" again will stop the focus motor.

If active, a 'check mark' will immediately precede this menu selection.  This menu selection is valid only
when using the Meade telescope system.

3.7.3.7 Set LX200 Time

The Set LX200 Time menu selection sets the time used by the LX200 or LXD telescope to the current time
as provided by your PC's clock.  If you use this function make sure that the PC's time has been set very accurately,
otherwise telescope positioning accuracy may be degraded.  This menu selection is valid only when using the Meade



telescope system.

3.7.3.8 Set LX200 Geographic Location

The Set LX200 Geographic Location menu selection sets the geographic location used by the LX200 or
LXD telescope to that currently used by ECU.  This menu selection is valid only when using the Meade telescope
system.

3.7.3.9 Set Encoder Interface Resolution

The  Set Encoder Interface Resolution menu selection is used to "program" the number of counts per
revolution for each optical encoder into the encoder interface.  This procedure only needs be carried out once and is
only necessary when using a newer version (software version of 1.7 or later) of the Jim's Mobile, Inc. SGT-MAX
(sometimes referred to as a BBox) or NGC-MAX encoder interface.  

Before  selecting  this  menu  item,  enter  the  actual  encoder  resolutions  for  each  telescope  axis
(altitude=declination  and  azimuth=right  ascension)  into  the  dialog  box  provided  by  the  menu  item  Encoder
Interface Settings (see section 3.7.3.12) and press "OK".  Then select this menu item to "program" the encoder
interface.  If an error message is displayed, check your connections and make sure the encoder interface is turned on.

If successful,  re-enter the menu item  Encoder Interface Settings and enter the values 32768 for both
resolution entries and press "OK".  Use the "Save" or "Save As..." function to permanently save these settings.

This menu selection is valid only when using the optical encoder interface system.

3.7.3.10 Select Alignment Stars

The Select Alignment Stars menu selection provides a sub-menu allowing up to two alignment stars, used
by the optical encoder interface system, to be selected.

Alignment stars can be picked from any star in the "Yale" star catalog, which includes all stars visible to the
naked  eye  (to  magnitude  6.5).   To select  an  alignment  star,  "click"  on  the  desired  star,  then  select  either  1st
Alignment Star or 2nd Alignment Star.  The last "Yale" star that you have "clicked" on is always used.  You must
have previously selected a "Yale" star or an error message will be display.  

For maximum accuracy, you should select alignment stars carefully by selecting stars that you can easily
identify in the "real" sky and stars which cause both axis of the telescope to move significantly when you move the
telescope between the stars.  An example of this would be to select one star low in the south and another high in the
northeast.

If the one-star alignment process is used, it is best select a star near the celestial equator. 

3.7.3.11 General Settings

The  General Settings menu selection presents a dialog box used to control the speed that the telescope
functions are updated and which communications port is used.

The "Update Delay", or speed is selected by pressing one of the "radio" buttons.  The "Update Delay" is the
dead time between attempts to communicate with either the Meade telescope or the encoder interface.  The actual



update rate depends on the response time of the interface and the speed of your computer.  The slower rates should
only be used if you find the telescope functions slow down your computer too much.

The "Port" selection should be set to the port that you are using to connect either your Meade telescope or
encoder interface.

Ending  the  dialog  box  is  accomplished  by  pressing  the  'OK'  button.   Aborting,  without  changing,  is
accomplished by pressing 'Cancel'.  This menu selection is valid when using either the Meade telescope system or
the encoder interface system.

3.7.3.12 Encoder Interface Settings

The Encoder Interface Settings menu selection presents a dialog box used to resolution and direction of
the optical encoders used in the encoder interface system.  It also provides check boxes for "Clock On" and a "Test
Mode".

If  you  are  using  a  newer  version  (software  version  of  1.7  or  later)  of  the  Jim's  Mobile  SGT-MAX
(sometimes referred to as a BBox) or NGC-MAX encoder interface, refer to section 3.7.3.9 for instructions on how
to "program" the unit.

If you are using a Micro-Guider or an older SGT-MAX or NGC-MAX, enter the actual encoder resolution
for each axis of the telescope.  There are usually the same, but do not have to be.  Be sure to include the effects of
any mechanical components, such as gears or pulleys.

The setting of the direction check boxes is telescope specific and requires some experimentation which will
be explained in section 6.2.

The "Clock On" check box should always be checked except if your telescope is a Dobsonian mounted on a
Poncet or other equatorial table.  Consult Nova Astronomics if your telescope is in this category.

When "Test Mode" is checked, a speci
al encoder test mode is entered.  This mode's operation will be explained in section 6.2.1.

Ending  the  dialog  box  is  accomplished  by  pressing  the  'OK'  button.   Aborting,  without  changing,  is
accomplished by pressing 'Cancel'.  This menu selection is valid only when using the encoder interface system.

3.7.4 Show Images Setup

The Show Images Setup... menu selection controls the location of object image files that can be displayed
within ECU and which image viewer program is to be used.

Viewing images of objects from within ECU is provided by running an image viewer program and passing
to it, the name of the image file to view.  This is accomplished by pressing the "Image" button from the "Identify
Object" dialog box of the object to be viewed.  If an image for the identified object or the image viewer program is
not present, the "Image" button will be disabled.

The image viewer program is not provided as part of your ECU purchase price.  There are several good
commercial image viewing programs available,  however,  the excellent  "shareware" viewer program  WinGIF is
provided on your "Main Program Disk" for your convenience.  WinGIF is "shareware" like ECU, so if you use it,
you must register it by sending US$15 to SuperSet Software Corp., PO Box 50476, Provo, UT, 84605-0476, USA.
WinGIF  must be installed as follows assuming that your hard disk is 'C' and your floppy disk is 'A'.



TYPE

1. Log to your hard disk: C:
2. Change to the ECU directory: CD\ECU
3. Make a directory to store image files:

MD GIFS
4. Install the ECU "Main Program Disk" in drive 'A'
5. Extract the files from WGIF.EXE: A:\WGIF
6. Install image files into the directory: "C:\ECU\GIFS".

At the moment, no image files are included with ECU; image disks will be available for a modest cost in
the future.  

When the Show Images Setup... menu item is selected, the dialog box below is displayed.

The name of the image viewer is entered first.  Its full name and location must be entered.  The default
viewer is "WINGIF.EXE" located in the ECU directory.  

The location of the image files is entered next.  The full path name with the trailing "\" must be entered.
The default directory is "GIFS", a sub-directory of the  ECU directory (usually "C:\ECU\GIFS").  Images can be
stored in this directory in several formats including "GIF", "TIF", "BMP", and "PCX".  The name of the image files
must be the same as the primary object's name that appears in the "Identify Objects" dialog box for the object.  For
example,  an image of the Moon would be called "MOON.GIF" if the image was in "GIF" format.  Or an image of
NGC7009 (the Saturn Nebula) would be called "NGC7009.BMP" if the image was in "BMP" format.  Messier
objects must be named by their NGC catalog number.   Note that  WinGIF can only read images in "GIF",
"BMP", and "PCX" format.

Ending  the  dialog  box  is  accomplished  by  pressing  the  'OK'  button.   Aborting,  without  changing,  is
accomplished by pressing 'Cancel'.  

3.8 Help

The Help menu has three entries.  The first selection, About ECU..., presents a message box identifying
ECU, its version number, its copyright notice, and how to contact the author.

The second selection,  Willman-Bell  Credits...,  presents  a message box identifying that  ECU contains
source  code  that  which  is  copyrighted  by  Jeffrey  Sax.   The  source  code  referred  to,  provides  high  accuracy
astronomical calculations based on the algorithms described in the book: Astronomical Algorithms by Jean Meuss
(distributed by Willman-Bell).  The message given in the message box is a requirement of distributing programs
containing Jeffrey's source code.

The third selection,  Other Credits...,  presents  a dialog box that  recognizes  the efforts of  the Saguaro
Astronomy Club,  and  the  Yale  and  Smithsonian  Observatory  for  the  preparation  of  their  deep  sky  and  stellar
databases respectively.  It also acknowledges Meade Instrument Corporation's trademarks.

4. Databases and Calculations

This section will describe the databases built-in to  ECU and the astronomical calculations used.  ECU
contains several databases.  The databases which will be covered in this section are the stellar database and the deep



sky database.  Other databases include the label, constellation line, and geographic location databases.

ECU uses the algorithms described in the book: "Astronomical Algorithms" by Jean Meuss for all of the
"high accuracy" solar system calculations and most other astronomical calculations as well.  The "low accuracy"
solar calculations are from the book: "Practical Astronomy with your Calculator" by Peter Duffett-Smith.

4.1 Stellar Database

The  stellar  database  is  divided  into  two  parts.   The  first  part,  the  Yale  Bright  Star  Catalog  (files
YBSC1.ECUand YBSC2.ECU), is standard with the REGISTERED version of  ECU.   It  contains 9110 stars to
magnitude 6.5 with a wealth of information about each star.  The other star database is the optional extended stellar
database, the Smithsonian Astrophysical Observatory (SAO) Star Catalogue.  The entire SAO catalog contains some
259,000 stars.  The Yale stars and those with the magnitude unknown were extracted leaving a database of  245654
stars to about magnitude 9.5.

Each  database  contains  the  magnitude  (visual,  if  available),  Right  Ascension,  Declination  in  J2000.0
coordinates and are displayed on the sky display using this epoch.  The Yale Catalogue provides several catalogue
numbers and names for each star.  These include the Bayer/Flamsteed identification, the Yale Catalogue number, the
SAO Catalogue number, and the Henry Draper Catalogue number.  The full spectral classification, colour as B-V,
and the proper motion of each star.  The SAO Catalogue provides the SAO Catalogue number and the spectral type.

The object positions in each database are stored in integer format obtaining a resolution of about 10 arc-
seconds in Declination and 20 arc-seconds in Right Ascension at the celestial equator.

4.2 Deep Sky Database

The deep sky database (files SAC1.ECU and SAC2.ECU) contains a complete database of 10367 deep sky
objects.  The members of the Saguaro Astronomy Club (SAC) (pronounced sa-war-oh) of Phoenix, Arizona have
provided much of the effort to compile this database (database version 5.2).  The database includes the entire NGC
catalog, plus other interesting deep sky objects.  Selected fields of the SAC database were extracted for use in ECU.
The object positions are stored in integer format obtaining a resolution of about 10 arc-seconds in Declination and
20 arc-seconds in Right Ascension at the celestial equator.  These fields are described below:

a) Object Name - usually the NGC number, but for objects with no NGC value, other catalogs are used.  The
abbreviations listed below are used to represent the other catalogs.  

Abell George Abell (planetary nebulae and galaxy clusters)
AM Arp-Madore (globular clusters)
Antalova (open clusters)
Bark Barkhatova (open clusters)
B Barnard (dark nebulae)
Basel (open clusters)
Berk Berkeley (open clusters)
Be Bernes (dark nebulae)
Biur Biurakan (open clusters)
Blanco (open clusters)
Bochum (open clusters)
Ced Cederblad (bright nebulae)
Cr Collinder (open clusters)
Czernik (open clusters)
Do Dolidze (open clusters)
DoDz Dolidze-Dzimselejsvili (open clusters)
Dun Dunlop (globular clusters)



Fein Feinstein (open clusters)
Frolov (open clusters)
Gum (bright nebulae)
H William Herschel (globular clusters)
Haffner (open clusters)
Harvard (open clusters)
He Henize (planetary nebulae)
Hogg (open clusters)
HP Haute Provence (globular clusters)
Hu Humason (planetary nebulae)
IC 1st and 2nd Index Catalogs to the NGC
    (All types of objects except dark nebulae)
Isk Iskudarian (open clusters)
J Jonckheere (planetary nebulae)
K Kohoutek (planetary nebulae)
King (open clusters)
Lac Lacaille (globular clusters)
Loden (open clusters)
LDN Lynds (dark nebulae)
Lynga (open clusters)
M Messier (all types of objects except dark nebula)
Mrk Markarian (open clusters and galaxies)
Mel Melotte (open clu
sters)
M1 Minkowski (planetary nebulae)
NGC New General  Catalog  of  Nebulae  &  Clusters  of  Stars  (All  types  of  objects  except  dark

nebulae)
Pal Palomar (globular clusters)
Pismis (open clusters)
PK Perek & Kohoutek (planetary nebulae)
RCW Rodgers, Campbell, & Whiteoak (bright nebulae)
Roslund (open clusters)
Ru Ruprecht (open clusters)
Sa Sandqvist (dark nebulae)
Sher (open clusters)
Sh Sharpless (bright nebulae)
SL Sandqvist & Lindroos (dark nebulae)
Steph Stephenson (open clusters)
Stock (open clusters)
Ter Terzan (globular clusters)
Tombaugh (open clusters)
Ton Tonantzintla (globular clusters)
Tr Trumpler (open clusters)
UGC Uppsala General Catalog (galaxies)
UKS United Kingdom Schmidt (globular clusters)
Upgren (open clusters)
vdB van den Bergh (open clusters, bright nebulae)
vdBH van den Bergh & Herbst (bright nebulae)
vdB-Ha van den Bergh-Hagen (open clusters)
Vy Vyssotsky (planetary nebulae)
Waterloo (open clusters)
Westr Westerlund (open clusters)

b) Other Name - contains other catalog designations that the object is known by.  The same abbreviations
as in a) are used.

c) Object Type - the type of object from the list below.

Asterism
Bright Nebula



Cluster with Nebulosity
Dark Nebula
Galaxy cluster
Galaxy
Globular Cluster
Diffuse Nebula in a Galaxy
Globular Cluster in a Galaxy
Cluster with Nebulosity in a Galaxy
Cluster with Nebulosity in the LMC
Diffuse Nebula in the LMC
Globular Cluster in the LMC
Open cluster in the LMC
Nonexistent in RNGC
Open Cluster
Planetary Nebula
Cluster with Nebulosity in the SMC
Diffuse Nebula in the SMC
Globular Cluster in the SMC
Open cluster in the SMC
Quasar
Unverified Southern Object
Multiple Star

d) Position - the object's position, Right Ascension and Declination, in the J2000.0 epoch.

e) Magnitude - the object's brightness to the nearest tenth.  There are many objects which have no published
magnitude; they are listed as ??.?.  Dark nebulae obviously have no magnitude, so they are also listed as ??.?.

f) Description - a visual description of the object.  Most of these are from the NGC, some are from prominent
amateurs.   Back  issues  of  Deep  Sky  Magazine,  Astronomy  magazine,  Sky  and  Telescope  magazine  and
Burnham's Celestial Handbook are used as a source of some of these descriptions.  The  descriptions use the
abbreviations from the NGC and Burnham's.  They are given below:

! remarkable object !! very remarkable object
am among n north
att attached N nucleus
bet between neb nebula, nebulosity
B bright P w paired with
b brighter p pretty (before F,B,L or S)
C compressed p preceding
c considerably P poor
Cl cluster R round
D double Ri rich
def defined r not well resolved, mottled
deg degrees rr partially resolved
diam diameter rrr well resolved
dif diffuse S small
E elongated s suddenly
e extremely s south
er easily resolved sc scattered
F faint susp suspected
f following st star or stellar
g gradually v very
iF irregular figure var variable
inv involved nf north following
irr irregular np north preceding
L large sf south following
l    little sp south preceding
mag magnitude 11m 11th magnitude



M middle 8... 8th magnitude and fainter
m much 9...13 9th to 13th magnitude

g) Size - the size of the object in minutes of arc (') or seconds of arc (").

h) Class - the class of the object.  Several professional classification schemes are contained here.

Trumpler type for open clusters

Concentration
I. Detached, strong concentration toward the center
II. Detached, weak concentration toward the center
III. Detached, no concentration toward the center
IV. Not well detached from surrounding star field

Range in brightness
1.  Small
2.  Moderate range
3. Large range

Richness
p Poor (<50 stars)
m Moderately rich (50-100 stars)
r Rich (>100 stars)

An "n" following the Trumpler type denotes nebulosity in cluster

Shapley-Sawyer concentration rating for globular clusters

The values range from 1 to 12, smaller numbers are more
concentrated clusters.

Vorontsov-Velyaminov type for planetary nebulae

1. Stellar
2. Smooth disk (a, brighter center; b, uniform brightness; c, traces of ring structure)
3. Irregular disk (a, very irregular brightness; b, traces of ring structure)
4. Ring structure
5. Irregular form similar to diffuse nebula
6. Anomalous form, no regular structure

Some very complex forms may combine two types.

Hubble type for galaxies

E elliptical, E0 is roundest to E7 is flattest subgroups; 'd'is dwarf, 'c'is supergiant, 'D' has diffuse halo
S Spiral, 'a' has tightly wound arms, 'b' has moderately  wound arms and 'c' has loosely wound arms
SB Spiral with central bar
Ir Irregular

5. Identify Objects

The identify objects dialog box, obtained by "clicking" on any object on the sky display with the left mouse
button, contains various information pertaining to the selected object.  Note that is the stars are not drawn with
"Auto Stellar Limit", you will not be able to "click" on stars.  See section 4.3.2 for details.



The information common to all object types includes the Right Ascension and Declination (in J2000.0
coordinates), the Altitude and Azimuth with reference to the local horizon, and the time the object rises and sets.
Each object type is listed below with each one's specific information that is displayed in the identify objects dialog
box.

a) Sun - the sun's distance, in astronomical units; and its size, in minutes of arc are displayed.

b) Moon - the moon's distance from the Earth, in kilometres; its size, in minutes of arc; its age, in days; and its
phase are displayed.

c) Planets - the planet's magnitude; its distance from the Earth, in astronomical units; its size, in seconds of
arc; and its phase (0 to 1) are displayed.

d) Comets or Asteroids - its magnitude; and its distance from the Earth and the Sun in astronomical units are
displayed.

e) Yale  Bright  Star Catalogue  Stars -  the  star's  magnitude;  its  Bayer/Flamsteed  identification;  its  Yale
Catalogue  number;  its  SAO  Catalogue  number;  its  Henry  Draper  Catalogue  number;  its  spectral
classification; its colour as B-V; and its proper motion.

f) Deep Sky Objects - the object's magnitude (if known); its primary and other names; its description; its
size; and its object class are displayed.  See section 4.2.

If more than one object is in the vicinity, the "Next" button can be pressed to update the dialog box with
new information for the next object.  The "Precess" button precesses the object's coordinates to the epoch of the
current date.  

Pressing the "Center" button will cause the sky display to be re drawn centered at the identified object. 

If  a  graphic  image for  the selected  object  is  present,  pressing  the  "Image" button  will  cause  it  to  be
displayed on the screen.  See section 3.7.4 for information about how to install and configure this feature. 

The "Sync" and "Center Scope" buttons are used by the telescope functions.  See section 6.1 for details.

The dialog box can be terminated in  four ways.   If  the  "Quit"  button is  pressed,  the  dialog  box will
terminate immediately.  If another object is selected, the current dialog box will be replaced with a new one.  If the
left mouse button is pressed while the cursor is not near an object, the dialog box will terminate.  Finally, the <ESC>
key can be pressed.

6. Using ECU's Telescope Interface Functions

ECU provides extensive support for the control of the Meade LX200 and LXD series of computerized
telescopes and equatorial mountings.  It  also provides support for optical  encoder interfaces (also called digital
setting circles) compatible with the Jim's Mobile, Inc. SGT-MAX, NGC-MAX, and many others from suppliers such
as Lumicon and Orion Telescope Center.

It also provides support for Nova Astronomics' own encoder interface:  The Micro-Guider.  The Micro-
Guider is not yet a commercial product, however sufficient support (including a PCB) and documentation can be
provided to allow the electronics-inclined amateur telescope maker (ATM) to build the device themselves for a to
tal cost of about US$175.  For further information, contact Nova Astronomics. 

This is the first version of ECU to contain telescope interface functions.  If you are having difficulties in
using these telescope interface functions, please make the author aware, so that any problems can be resolved.



Even though many of the menu selections, etc. used by the telescope interface functions in ECU are shared
by the Meade telescope system and the encoder interface system, they operate completely independently cannot be
operated simultaneously. 

Therefore,  their  operation  is  separately  described  in  sections 6.1  and  6.2.   Reference  material  for  the
telescope sub-menu selections is found in section 3.7.3. 

6.1 Using an LX200/LXD Telescope With ECU

To use a Meade LX200 telescope or LXD series telescope mounting (with #1697 computer drive system)
with ECU, you will need an RS232 cable to connect your telescope to your computer.  This should be available from
any Meade dealer, or you can make one yourself according to the instructions in your telescope instruction manual.
This cable can also be purchased from Nova Astronomics.

Before attempting to use ECU with your telescope, you should have read your telescope instruction manual
thoroughly and be able to confidently use it stand-alone without the aid of a computer.

6.1.1 Initial Set Up

The first time you use the Meade telescope interface, you may have to make some adjustments to ECU's
settings.  Enter the  General Settings... menu selection from the  Miscellaneous -> Telescope menu (see section
3.7.3.11 for details).  Select the communications port (COM1 or COM2) that is used to connect the telescope to the
computer.  Initially select the "update delay" to 0.1 seconds (this is the default).  If your computer operates slowly
when the telescope interface is enabled, try using a higher "update delay".

Save these settings permanently by using the File -> Save or File -> Save As... menu selections.

6.1.2 Enabling the Telescope Interface

Prior to enabling the telescope interface, a number of steps must be completed as listed below:

1. Connect the RS232 cable between the telescope and your computer.
2. Turn the telescope on.
3. Align the telescope following the procedure outlined in its instruction manual.  If desired, you can use the

Set LX200 Time... (see section 3.7.3.7) and Set LX200 Geographic Location... (see section 3.7.3.8) menu
selections.

4. Enable the telescope interface by selecting the Enable Meade LX200 menu selection (see section 3.7.3.1).
5. If no error messages were displayed, the telescope interface should be functional.

To disable the telescope interface, just select the Enable Meade LX200 menu selection again.

6.1.3 Using the Telescope Interface

Once  enabled  (see  section  6.1.2),  the  telescope  interface  is  quite  easy  to  use.   Several  functions  are
provided; each is described below.

1. Position Display - if the menu selection Show Position (see section 3.7.3.3) is enabled, a cross-hair will be
drawn on the sky display at the position which the telescope is pointed to and will follow it in real-time.  If
the menu selection Track Telescope (see section 3.7.3.5) is enabled, and the telescope position moves out



of the sky display, it will be re drawn with the current telescope position at the center of the sky display.

2. Coordinate Display - if the menu selection Show Coordinates (see section 3.7.3.4) is enabled, a window
will be visible which displays the real time equatorial coordinates of the telescope.

3. Manual Telescope Control -  if  the menu selection  LX200 Control (see section 3.7.3.6) is  enabled, a
dialog box will be visible which allows manual control of the telescope motions and focus.

4. Slew to Object - the user can instruct the telescope to automatically slew to an object in the sky by first
selecting the object from the sky display (with the left mouse button) and then pressing the "Center Scope"
button from the "Identify Object" dialog box.  If the object is below the local horizon or the "higher limit",
an error message will be displayed, otherwise the telescope will slew to the object.

5. Synchronize Telescope - the user can instruct the telescope to re-synchronize its current coordinates to
known coordinates.  This improves the pointing accuracy of the telescope.  The usual procedure is to first
use the slew function (see number 4 above) to find an object.  Due to various errors, the object will not
likely be in the exact center of the field of view of the telescope.  Use the telescope's manual controls to
position the object in the center of the field of view.  Then, finally, select the same object again with the left
mouse button and press the "Sync" button from the "Identify Object" dialog box.

6.2 Using an Encoder Interface With ECU

To use an encoder interface with ECU, you will need, as a minimum, the following components:

1. Optical encoders mounted on both axis of your telescope.
2. An interface box (called the encoder interface) to translate the encoder signals into RS232 format.
3. An RS232 cable to connect the interface box to your computer.

There are many encoder interfaces on the market available from several suppliers.  Not all of these have the
required RS232 interface.  Many of these units are manufactured by the same company and are compatible with each
other and thus ECU.  

Some of these encoder interfaces are self-contained (that is, they can operate by themselves using their own
integral display without the need for a separate computer), others are simpler, relying on a computer running a
program such as ECU.  These instructions will assume that you are using the simpler type, such as the Micro-Guider
or Jim's Mobile, Inc. SGT-MAX, which is also sometimes referred to as a "BBox".

6.2.1 Initial Set Up

The first time you use the encoder interface system, you will have to make some adjustments to  ECU's
settings to match your specific telescope and encoder interface.

Enter  the  General  Settings... menu selection from the  Miscellaneous -> Telescope menu (see section
3.7.3.11 for details).  Select the communications port (COM1 or COM2) that is used to connect the encoder interface
to the computer.  Initially select the "update delay" to 0.1 seconds (this is the default).  If your computer operates
slowly when the telescope interface is enabled, try using a higher "update delay". 

Select the Encoder Interface Settings...  menu selection.  Enter your optical encoder resolutions according
to the instructions outlined in section 3.7.3.12.

The "Reverse Direction" check boxes are necessary because of the various ways that encoders are installed
on different models of telescopes. ECU provides a "Test Mode" (activated by the its check box) which can be used



to experimentally determine if the direction of each encoder needs to be reversed.

Connect the RS232 cable between the telescope and your computer and turn on the encoder interface.  After
you have enabled the "Test Mode", select the Enable/Align Encoder Interface menu selection.  When the "Align
Altitude Encoder" dialog box is displayed, press the "1 Star" button.  A window similar to that shown below will be
displayed.

As you move your telescope, its Azimuth (Azim) and Altitude (Alt) will be displayed in real-time.  The
Azimuth angle should increase as the telescope is moved counter-clockwise, as viewed from above.  The Altitude
angle should increase as the telescope is moved to the north (or up).  If either of these motions is incorrect, reverse
the corresponding "Reverse Direction" check box in the Encoder Interface Settings...  menu selection.

The "Test Mode" can also test the encoder resolution settings.  Verify that  the azimuth readings move
smoothly from 0º  through 360º  for  one complete rotation of the telescope and that  the altitude readings move
through a span of 90º as the telescope is moved one quarter of a turn.  When finished with the "Test Mode" be sure
to disable it.

Save the settings permanently by using the File -> Save or File -> Save As... menu selections.

6.2.2 Enabling the Encoder Interface

Prior to enabling the encoder interface you must first connect the RS232 cable between the telescope and
your computer and turn on the encoder interface.

The encoder interface must be aligned using either one or two stars in the sky.  ECU uses these stars as
reference points when translating the optical encoder readings into right ascension and declination.  The one star
alignment process can only be used for equatorial mounted telescopes that are known to be accurately aligned with
the celestial pole.  Otherwise, the two star alignment process should be used.

Select and enter your alignment star(s) into ECU according to the instructions in section 3.7.3.

Select the Enable/Align Encoder Interface menu selection (see section 3.7.3.2).  If you have aligned the
encoder interface previously since running ECU, the message below will be displayed.

You can press the "Yes" button if you have not moved your telescope mounting or turned off your encoder
interface, otherwise press the "No" button.

Next, the dialog box below will be displayed.  The telescope's altitude (or declination) axis must be aligned
to either 0º or +90º (whichever is convenient) and the appropriate "radio" button pressed.  If you have performed this
step since turning on your encoder interface, you can press "skip" to ignore this step. 

Press either the "1 Star" or "2 Star" button , "Cancel" to abort the alignment process.

The sky display will  re-draw with the first  alignment star positioned at  the center of the screen and a
message similar to that below will be displayed.  Point the telescope exactly at the first alignment star and press the
"Continue" button.

If  you  are  performing  a  two  star  align,  the  sky  display  will  re-draw  with  the  second  alignment  star
positioned at the center of the screen with another message displayed.  Point the telescope exactly at the second
alignment star and press the "Continue" button.

The alignment process is complete.  The encoder interface can be disabled by selecting the Enable/Align
Encoder Interface menu selection again.



6.2.3 Using the Encoder Interface

Once enabled (see section 6.1.2), the encoder interface is quite easy to use.  Several functions are provided;
each is described below.

1. Position Display - if the menu selection Show Position (see section 3.7.3.3) is enabled, a cross-hair will be
drawn on the sky display at the position which the telescope is pointed to and will follow it in real-time.  If
the menu selection Track Telescope (see section 3.7.3.5) is enabled, and the telescope position moves out
of the sky display, it will be re drawn with the current telescope position at the center of the sky display.

2. Coordinate Display - if the menu selection Show Coordinates (see section 3.7.3.4) is enabled, a window
will be visible which displays the real time equatorial coordinates of the telescope.

3. Find an Object - to locate an object in the sky, select the object in the sky display with the left mouse
button and press the "Center Scope" button.  This will cause a dialog box (shown below) to appear on the
screen.  Move the telescope until both the coordinates displayed read zero (or nearly so).  To make this
process easier, when the telescope is closer than 2 degrees from the object in either axis, a "beeping" sound
will be heard.  This feature eliminates the necessity of looking at the computer screen while moving the
telescope, except for the final positioning.  To silence the "beeping" sound, press the "*" button or the "B"
key on the keyboard.

The best method to find objects is to move each axis of the telescope separately.  Move the first axis until
the "beeping" sound is heard. Silence the sound.  Move the second axis until the "beeping" sound is heard
again.   Silence  the  sound.   Zero  in  on  the  object  by  fine  adjusting  the  telescope  position  until  the
coordinates display reads zero.  End the process by pressing the "OK" button. 

4. Synchronize Telescope - if you used the one star alignment process, you can re-synchronize the current
coordinates  to  known coordinates.   This  improves  the  pointing  accuracy  of  the  telescope.   The usual
procedure is to center a known object in the exact center of the telescope's field of view.  Then, select the
same object from the sky display with the left mouse button and press the "Sync" button from the "Identify
Object" dialog box.

7. The Future of ECU
Below is a partial list of the features, in no particular order, which are coming in future releases of ECU.

Please send the author your own suggestions for improvements or additions.

- allow the time to be set by Julian date
- allow star charts to be exported as Windows "meta" files
- add a double star database
- add a 'button bar' for quick access to common functions
- make the status area a window, so it can be turned off, if desired
- add extended labeling of all objects on the sky display.  This would include catalog numbers, Bayer and

Flamsteed designations, magnitudes, etc.
- allow fonts for labels to be set by the user
- improve the chart printing by including extended labeling, programmable fonts, etc.
- allow the user to enter information to be printed in the "notes" area of the printed charts
- a local  horizon mode that  will always display the horizon parallel to the bottom of the screen (highly

desired).
- provide a facility to easily add to and change the geographic location database
- separate the Messier database from the SAC database and expand the Messier database information.



- update the SAC deep sky database to V6.0
- add the position angle into the moon's phases
- add a dialog box for the label and line settings
- add a facility to output an observing list the of objects currently on the sky display
- add the Earth's shadow so lunar eclipses can be simulated
- add a facility to output a solar system ephemeris
- add more common star names and cross reference them to their Yale equivalent
- add common deep sky object names and cross reference them to the deep sky database
- add "Center on Common Deep Sky..."
- improve the animation mode by showing the date and time next to object trails and allowing the trails to be

continuous lines
- Hubble Guide Star Catalog CDROM support
- add ability for the user to add objects to the database
- add ability for the user to add customizable object labels
- allow the user to add descriptions (an observing log) of objects
- add display of Jupiter's moons
- add display of Saturn's moons/rings
- provide some GIF images
- provide auto coordinate grid scaling
- all smaller field sizes
- add more keyboard functions to allow for easier use in the field
- and many other smaller items


